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CS Customer Services 
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FAD Financial Accounts Department 

HNG-X Horizon Next Generation — Plan X 
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IRE11 The active data centre in Ireland that replaces the Bootle data centre 

IRE19 The DR failover data centre in Ireland that replaces the Wigan data centre 
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SSC Software support centre 

TMS Transaction Management System 
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Gatherer The module responsible for collecting the audit files from the hosts, agents, 
correspondence servers and interface mechanisms. This module is also 
responsible for the application of the audit file naming policy. 

Sealer The module responsible for calculating the checksum seal of each audit 
data file before it is written to the audit archive. This value is recalculated 
after data is extracted by the Retriever and compared to the original value 
when first sealed. Used to ensure data integrity during storage on audit 
archive. 

Retriever The module responsible for moving audit data from the buffers where it is 
placed when retrieved by Eternus. 

Extractor The Client/Server system responsible for retrieving data from Eternus and 
managing Audit Data Extractions. 

Eternus Online mass disk storage unit selected by the Royal Mail Group Account to store 
and manage audit data. 

Sec Ops The team that runs ARQs and sends the results to the Post Office. 

Fujitsu Services endeavours to ensure that the information contained in this document is correct but, whilst every 
effort is made to ensure the accuracy of such information, it accepts no liability for any loss (however caused) 
sustained as a result of any error or omission in the same. 

1 II' 

There are no security risks relating specifically to this document. 
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In addition to the historic data collected under Horizon, the HNG-X system generates significant amounts 
of data that is of interest to Post Office Ltd Internal Audit (POLIA) and other groups. 

This document describes the Audit Extraction Client application that is run on the Audit Workstations 
(AUWv2s). The AE client provides functionality to manage Audit Record Queries (ARQs) and to retrieve 
and process audit data from the audit archive. 

2 Scope 
This document describes the functionality provided by the Audit Extraction Client for the retrieval, 
filtering and querying of audit data and the managing of Audit Record Queries (ARQs). 

It does not provide any details of the processes involved in handling requests for audit data. For process 
information see document SVM/SEC/PRO/0017 — Management of the Prosecution Support Service for 
Audit Record Queries. 

Within this document certain terms are used which have specific meaning within the audit solution. They 
are: 

Filtering : Filtering is the process of searching the retrieved audit files for specified FAD codes 
or strings in order to select a subset of data for further processing. The user has the 
option of selecting the whole file in which a match is found or of just selecting the 
matching messages or records. 

Query: A specification using the XQuery language for the selection of messages and 
message attributes from retrieved audit data. A number of standard queries are 
provided as part of the audit system. 

Querying: Querying allows the selection of the message attributes to be included in the final 
output and also allows for a finer granularity of message selection to be applied. 

The Audit Extraction Client is compatible with the HNG-X Security Architecture (see 
ARC/SEC/ARC/0003 — HNG-X Technical Security Architecture). 

The integrity of audit data must be guaranteed at all times and controls have been established to provide 
assurances to Post Office Internal Audit that this integrity is maintained. 

During audit data extractions the following controls apply: 

1. Extractions can only be made through dedicated Audit Workstations (AUWv2s) which exist at 
Bracknell and Lewes. The AUWv2s are subject to rigorous physical security controls: they are 
located in secure rooms subject to proximity pass access within a secured Fujitsu Services site. 

2. Logical access to the AUWv2s and their functionality is controlled by two-factor authentication 
using dedicated logins, password control and a second authentication factor. 
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3. Checksum seals are calculated for audit data files when they are written to the audit archive and 
re-calculated when the files are retrieved. 

6~[3'11 i~- uII- t 
The diagram below details the process of retrieving Audit Files from the Audit system. 

In brief the process comprises: 

1. Define the Audit Files to be retrieved. 

2. Retrieve list of matching files from the Sealer database. 

3. Submit the list for retrieval from the Audit Eternus. 

4. Seal check the retrieved Audit Files, comparing the generated seal with the value held for the 
Audit File at the Sealer database. 

5. Optionally, filter or query the retrieved data. 
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Figure 1 - Audit File Retrieval 
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The audit extraction process assumes that audit data has been gathered, sealed and written to the audit 
archive. The main types of files that are gathered are: 

a. TMS Journals from the Correspondence Servers (Horizon) 

b. Branch Database Journal Messages (HNG-X) 

c. Output from database tables 

d. Transaction files to and from PO systems (via gateways) 

e. Tivoli Event files 

f. NBX 

g. Output from APOP database tables 

All file types are referenced in DEV/INF/ION/0001. 

The following table lists the different groups that can request audit data and shows how these map to the 
Requester value that is selected on the New ARQ or Fast ARQ forms: 

Group requesting audit data Requester value 

Post Office Limited, Internal Audit POCL IA 

Post Office Limited, Security POCL Security 

Post Office Limited, Other POCL Other 

Fujitsu Pathway, Internal Audit Pathway IA 

Fujitsu Pathway, System Support Centre Pathway SSC 

Fujitsu Pathway, Other Pathway Other 

Other 31d Parties (e.g. police) Other 3 d̀ Party 

The following paragraphs present an overview of each step in the extraction process and are ordered to 
reflect the actual processing of an ARQ. 

All POLIA requests for audit data are made via the standard Audit Record Query form, generally sent via 
e-mail. Details of outlet, Branch Code and timeframes are required in order to fulfil the request. In 
addition to this, specific requirements may be requested. 

Contractual limits and turnaround times for the provision of Audit Record Queries are detailed in the 
document SVM/SDM/SD/0017. 

Internal requests for data extraction will be in the form of a Peak on the CS Security stack. 
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6.1.1 Marking Files 
The audit data files required to satisfy the audit data request are marked for retrieval. 

6t2 Audit File Retriever 
Retriever copies the requested files from the Eternus buffers and makes them available to the Sealer for 
seal verification. 

To assure the integrity of the audit data while on the audit archive, the checksum seal for the file is re-
calculated by the audit file sealer and compared to the value calculated when the file was originally 
written to the audit archive. The result is maintained in a check seal table. 

This is a facility that uses various tools to extract or reform the retrieved audit data in accordance with 
the ARQ for despatch to the ARQ originator. 

There are Audit Workstations located at both the Bracknell and Lewes Fujitsu offices. These machines 
are not connected to the Fujitsu network but have direct lines to the IRE1 1 and IRE1 9 Audit Servers. 

The Audit workstation implements the HDCR Windows 10 Secure Workstation build. Restricted access 
to workstation functionality will be implemented based upon the MSAD group to which the user belongs. 

Two groups exist for Audit Workstation access: 

1. Audit Users 

The standard user account. Members of this group will be able to perform extraction and 
analysis of data held on the Audit system. 

2. Audit Admin 

Grants access, from the Audit workstation, to the operational area of the Audit servers to allow 
investigative and maintenance tasks to be performed. 

Access to the Audit workstation is via two-factor authentication: the user requires an Key security token 
and a PIN number. The user inserts their IKey token into a USB port on the audit workstation and is then 
presented with a screen on which to enter their PIN number. 
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The Audit Extraction Client application implements a multiple document interface allowing access to 
multiple ARQs across all servers simultaneously. 

The concept of WIGAN and BOOTLE servers has been retained. The IRE11 data centre is equivalent to 
BOOTLE and the IRE19 data centre is equivalent to WIGAN. 

Initially the application can be accessed by double clicking on the file C:\Program Files 
(x86)\AuditExtractorCl ient\AEClient.exe. 

However it is recommended, to speed access in the future, the user right clicks on the file and selects 
either "Pin to Start" or "Pin to startbar". 

E:W 
urn iiiii

To start the client in future click the "Start Button" (or press the Windows Key), scroll down and select the 
Audit Client — 

flhI TT 

To start the client in future click on the AEClient icon .at the bottom of the screen - 

: c fl  It; Flu i1a& 11Z1 ii1I.] 
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Audit Extraction Client Application 
Vers on 14 16 (re risic;n 4) 

,d. Iii hngrunhyur tlon :....................... _...._._......._........._....... 
General Temp Files • D:\ClientQuerylemp 
Validation successful. 
Checking session details. 
Initialising server access. 
---Checking Server IRE11 
---.--RFI DB not connected. 

Figure 2 - Audit Extractor Client Splash Screen 

POST 
OFFICE 

Once started the application performs a number of checks to ensure that the environment has a valid 
configuration, and that at least one Audit server is accessible. 

During the check the Audit Extraction Client splash screen (Figure 2) is displayed. 

In the event of a configuration error being detected, or no Audit servers being accessible, an appropriate 
message is displayed to the user and execution terminated. If this occurs, Audit support should be 
contacted. 

Upon successful completion of the validation, the splash screen will briefly show a list of connected Audit 
servers before displaying the main Audit Extraction Client form. 

. I 11 nil au liii 
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Figure 3 - Audit Extractor Client Main Multiple Document Interface form 

The main form (figure 3) allows access to all of the Audit Extraction Client features, encapsulating ARQ 
management, data retrieval and data extraction. 

The form is a multiple document interface which allows multiple ARQs to be open simultaneously. 

t; fi

© Copyright Fujitsu Services FUJITSU RESTRICTED (COMMERCIAL IN Ref: DEV/GENIMAN/001 5 
Limited 2009-2017 CONFIDENCE) Version: 9.0 

UNCONTROLLED IF PRINTED Date: 21 May 2018 
Page No: 16 of 72 



FUJO0158710 
FUJO0158710 

Audit Extraction Client User Manual 

FUJITSU RESTRICTED (COMMERCIAL IN • 
CONFIDENCE) 

r D roelc windo. r+alp 

Figure 4 - Audit Extractor Client Main form showing File menu 

The File menu has five sub-menu items: 

Fast ARQ 

Displays the Fast ARQ form. When selecting this option the user will be required to supply the 
data centre at which the ARQ should be created. 

New ARQ 

Displays the New ARQ form. When selecting this option the user will be required to supply the 
data centre at which the ARQ should be created. 

Open ARQ 

Displays the Open ARQ form. When selecting this option the user will be required to supply the 
data centre at which the ARQ to be opened was created. 

Close ARQ 

Displays the Close ARQ form. When selecting this option the user will be required to supply the 
data centre at which the ARQ to be closed was created. 

Exit 

Closes the application. 
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Figure 5 - Audit Extractor Client Main form showing Tools menu 
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The Tools menu has one sub-menu item called PAN Manipulation that displays the PAN Management 
dialogue. 

Figure 6 - PAN Management Dialogue 

The PAN Management dialogue allows the user to enter a PAN in clear, encrypted or hashed form and 
generate other forms of the PAN value. 

The output generated for each entry type is shown in the table below: 
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Entry Type Output 

Clear Clear and Hashed 

Hashed Hashed 

Encrypted Clear and Hashed 

POST 
OFFICE 

It should be noted that for Audit purposes there is no requirement to encrypt clear PANs. 

Actions performed via this dialogue are recorded for internal audit purposes (see DEV/APP/SPG/0016 — 
Audit Extraction Client Support Guide for details). 

Figure 7 - Audit Extractor Client Main form showing Window menu 

The Window menu has one sub-menu item: 

Cascade 

Allows open forms within the MDI form to be arranged as cascaded windows. 

t 
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The Help menu has one sub-menu item called About that displays a message box showing the version 
number of the AE client application. 

Figure 9 — About message box 

The toolbar provides buttons for the following operations: 

© Copyright Fujitsu Services FUJITSU RESTRICTED (COMMERCIAL IN Ref: DEV/GENIMAN/001 5 
Limited 2009-2017 CONFIDENCE) Version: 9.0 

UNCONTROLLED IF PRINTED Date: 21 May 2018 
Page No: 20 of 72 



FUJO0158710 
FUJO0158710 

cO Audit Extraction Client User Manual 

FUJITSU FUJITSU RESTRICTED (COMMERCIAL IN 
CONFIDENCE) 

• Create a new fast' ARQ 

• Create a new `slow' ARQ 

• Open an ARQ 

• Close an ARQ 

843 Data Centres Pane 

P 
FI 

The Data Centres panel (see Figure 3) is tied to the left side of the screen and consists of two parts: 

1. The Data Centres section in the top part of the panel displays the status of all configured data 
centres and lists active ARQs under the data centre at which they were created. 

2. The Available Forms section in the lower part of the panel displays icons representing any open 
forms that have been minimised. 

The relative sizes of the two sections can be changed by clicking on the top edge of the Available Forms 
`title bar' and dragging it with the mouse. 

The Data Centres section provides access to a number of functions, as well as providing a graphical 
indication of system and ARQ status. 

Clicking on an icon in the Available Forms section restores the form to its original size. 

8.4.3.1 System Status 

The Audit Extractor Client periodically checks whether a connection can be made to each of the 
configured data centres. The results are indicated by the icon displayed to the left of the data centre 
name and by descriptive text following the name. 

A data centre is considered to be connected if both the RFISQL and SEALERSQL databases can be 
accessed. 

Icon Status Meaning' 

0 Connected The data centre is accessible and useable 

12 Not Connected One or both of the RFISQL and SEALERSQL databases are inaccessible. No ARQ 
actions are possible. 

The ARQ Status, as indicated by the icon to the left of the ARQ, has one of the following values: 

Icon Status Meaning' 

Q Normal The ARQ is available. 

0 Open The ARQ is open in the current user session 

0 Locked The ARQ is locked by another user or at a different work station. The ARQ cannot be 
opened by the current user while in this state. 

' U Attention The ARQ has been opened by the current user, at the current work station but under a 
different session. The ARQ must be reset using the AEAdmin tool. 

8.4.3.3 Functional Access From Data Centres Window 
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Quick access to the Fast, New, Open and Close ARQ forms is gained by right clicking on the required 
data centre. When these forms are accessed via this route the target data centre is automatically 
completed and does not show on the forms. 

Where active ARQs are displayed, right clicking on the ARQ will display a drop down menu with the 
following options: 

Open - For a slow' ARQ, opens the selected ARQ at the current stage. 

For a `fast' ARQ, opens the selected ARQ in the Fast ARQ form. 

Status - Displays the ARQ Status form. 

Close - Displays the Close ARQ form populated with the selected ARQ details. 

Double clicking on an active ARQ will open a slow' ARQ at the current stage or a 'fast' ARQ in the Fast 
ARQ form. 

When a fast' ARQ is re-opened, all the fields of the Fast ARQ form are read only. No further updates 
can be made to the ARQ. 

E:L 1ti1W1z(,1

8.5.1 Creating a New ARQ 

j l 

Data Ce 
_.r 

Query 

Requester  Date Received 26101/2009 ..1 

Catalogue Entry 
r 

Date Requited 26101/2009 

Receipt Reference

Access Reason 

Figure 10 - New ARQ form 

This option is used to setup an audit trail for a request and to specify the search criteria identified from 
the ARQ form. 
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The New ARQ form can be displayed in three ways: 

1. Select 'New ARQ' from the File menu. 
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When opened from the File menu, the New ARQ form will be displayed as in Figure 10. The 
Data Centre frame at the top of the form allows the selection of the data centre in which the new 
ARQ is to be created. 

2. Click the New ARQ' button in the toolbar. 

When opened from the toolbar, the New ARQ form will be displayed as in Figure 10. The Data 
Centre frame at the top of the form allows the selection of the data centre in which the new ARQ 
is to be created. 

3. Right click on the required data centre and select New ARQ' from the drop down menu. 

When opened by right clicking a data centre, the Data Centre frame is not shown in the form as 
the data centre will automatically be set to the one which was clicked. The title bar of the form 
shows the name of the selected data centre. 

Field Input Value Mandatory ~~ a 

Data Centre (if displayed) The data centre at which the ARQ is to be created. 

Select From: 

Mandatory 

Requester Mandatory 

Other 3`d party 

Pathway IA 

Pathway Other 

Pathway SSC 

POCL IA 

POCL Other 

POCL Security 

Date Received The date the request was received. Mandatory 

Date Required The date the request is to be returned. Mandatory 

Catalogue Entry Is left blank. Not used 

Receipt Reference ARQ Number, taken from the ARQ form. Mandatory 

Access Reason Reason for request. Optional 

Once the mandatory data has been entered one of the following actions may be performed: 

Specify Selection Criteria 

Saves the ARQ details to the RFI database, creates the ARQ directory structure in F:\UserArea 
on the selected Audit Server and displays the Specify Selection Criteria form (see section 8.5.3). 

Save Request 
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Saves the ARQ details to the RFI database and creates the ARQ directory structure in 
F:\UserArea on the selected Audit Server. 

(F:\UserArea is a folder of the Audit Server that contains a sub-directory for each ARQ.) 

The newly created ARQ will be displayed underneath the appropriate data centre in the Data Centres 
window. 

P
. 

Data Centre 

Query Reference 
f j 
~hov~ Query Dekails 

Acceso Reaoon 

Figure 11 - Open ARQ form 

An active ARQ may be opened in five ways: 

1. Select `Open ARQ' from the File menu. 

When opened from the File menu, the Open ARQ form will be displayed as in Figure 11. The 
Data Centre frame at the top of the form allows the selection of the data centre from which the 
ARQ is to be opened. 

2. Click the 'Open ARQ button in the toolbar. 

When opened from the toolbar, the Open ARQ form will be displayed as in Figure 11. The Data 
Centre frame at the top of the form allows the selection of the data centre from which the ARQ is 
to be opened. 

3. Right click on the required data centre and select 'Open ARQ' from the drop down menu. 

When opened by right clicking a data centre, the Data Centre frame is not shown in the form as 
the data centre will automatically be set to the one which was clicked. 

4. Right click on a specific ARQ in the Data Centres window and select Open from the drop down 
menu. 
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Right clicking on a specific ARQ will result in either the Specify Selection Criteria or Maintain 
ARQ forms being displayed, depending on the status of the selected ARQ. 

5. Double click on the ARQ in the Data Centres window. 

Double clicking on a specific ARQ will result in either the Specify Selection Criteria or Maintain 
ARQ forms being displayed, depending on the status of the selected ARQ. 

Field Input Value 

Data Centre (if displayed) The data centre at which the ARQ is to be opened - 
selected from drop down list. 

Query Reference The ARQ to be opened - selected from drop down 
list of query references. 

Access Reason Access reason as entered when ARQ was created. 
This is a read-only field. 

Once the data centre and query reference have been selected, one of the following actions may be 
performed: 

Show Query Details 

Displays a form showing details of the selected query (see section 8.5.2.1). 

Open Query 

Opens the ARQ at its current stage. 

Clicking the Close button will close the Open ARQ form. 
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Selection Criteiia for .ARQ Reference 0TH3233B 
Coate,- Flequred 

From Date F1 i Ict;ter 20ir9 ' J To Date 121 October 2005 

Audit Point arid FAD Detal!:; 

Audit Point Audit Sub f conk FAD i ndN FAD Ha f! 

FAN D -mail: - Requited Template:: 

Hori2on Template 

HN X Template 

Request Details for ARQ Reference OTH 32336 —
_

09 j Requester  r : .rd Part,,, Date Received 21A10/2009 

Catalogue Entry Date Required 21/1012009 *' 
I 

Receipt Reference ,t•t'1 

Access Reason
r 
I,l.,ege,legeq 

..~.. .~.. .~..-.-., 

Figure 12 — Details of Current Query form 

This form is displayed when the 'Show Query Details' button is clicked on the Open ARQ or Close ARQ 
forms. 

It shows details of the selected request. Some of the fields may be empty, depending on the current 
stage of the request. 

All of the fields are read-only. 
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Selection Criteria for ARQ Reference 0TH3235B 
Dates Required 
From Date i Urt t:r 20it9 

vi 

To Date i5: =i sobe 2009 

Figure 13 - Specify Selection Criteria form 

This form provides the central point for specifying the Audit Files for retrieval 

POST 
OFFICE 

The form may be closed (without closing the ARQ) by selecting the Close button. Provided no audit 
points or templates have been selected, the form is closed and the ARQ remains at its current stage. If 
any audit points or templates have been selected, a dialogue box is displayed asking the user to confirm 
that the selections are to be discarded (see figure 14). 

Message 

This selection criteria has not been saved. Do you want to discard? 

Cancel 

Figure 14 — Discard Selection dialogue 

© Copyright Fujitsu Services FUJITSU RESTRICTED (COMMERCIAL IN Ref: DEV/GENIMAN/001 5 
Limited 2009-2017 CONFIDENCE) Version: 9.0 

UNCONTROLLED IF PRINTED Date: 21 May 2018 
Page No: 27 of 72 



FUJO0158710 
FUJO0158710 

Audit Extraction Client User Manual 

FUJITSU ' FUJITSU RESTRICTED (COMMERCIAL IN • 
CONFIDENCE) 

If the user clicks 'OK', the dialogue box and Specify Selection Criteria for Query form will be closed and 
the ARQ remains at its current stage. Upon re-opening, the ARQ will resume with the Specify Selection 
Criteria for Query form. 

If the user clicks 'Cancel', the dialogue box is closed but the Specify Selection Criteria for Query form 
remains open. 

All retrievals must include the 'From Date' and 'To Date' and either an Audit Point or a template or both 

From Date - The earliest date for which Audit Files are to be retrieved 

To Date - The last date for which Audit Files are to be retrieved 

Audit Point - Audit Point to which the selected Audit Sub Point belongs 

Audit Sub Point - Audit Sub Point from which Audit Files should be retrieved 

Horizon Template - Template for matching Horizon Audit File names 

HNG-X Template - Template for matching HNG-X Audit File names 

From and To Dates are selected by clicking on drop-down arrows adjacent to the date fields and 
selecting the required date. 

When extracting HNG-X transaction data, the 'From Date' should be set to at least the day before the 
date for which the extract is required. This is because it is necessary to capture the logon messages for 
the counter session of interest in the retrieved Audit Files. The logon messages contain cryptographic 
keys that are used to digitally sign the counter messages and failure to capture these logon messages in 
the extract may result in cryptographic errors during filtering. 

Since a counter session can span more than one day, setting the 'From Date' to a date earlier than the 
first date for which the extract is required improves the chances of the session logon messages being 
included in the retrieved files. 

The 'To Date' is usually set to two days after the last date specified on the ARQ. An Audit File may not 
be gathered until one or two days after it was created so adding extra days to the 'To Date' helps to 
ensure that all the required Audit Files are retrieved. 

Audit Points and Audit Sub Points or FAD codes are selected by clicking on the '<Select' button which 
will display the Update Audit Points form (see section 8.5.3.1) 

NBX Query details and template formats may be specified by clicking on the Select PAN button (see 
section 8.5.3.2). If template formats are specified, only those Audit Files whose filenames match the 
specified templates will be retrieved. That is, if both Horizon and HNG-X templates have been specified, 
Audit Files whose names match either of those templates will be retrieved. 

Once all of the required extraction criteria have been specified, the user can click the "Search for Files" 
button to produce a list of Audit Files that match the selection criteria. The Maintain ARQ form will then 
be displayed (see section 8.5.4.1) showing the list of selected files. 
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To add selection criteria. Select Audit Point and Sub Point or input Post Office FAD Code, then click 'Add'. 

To remove selection criteria: Select criteria in list, then click 'Delete 

List of selected Audit Point Selection Criteria
NAu  glue; di  

Posit f -_ e .~ ._1 Audit Point 
-----`-'•------ 

Add r udit Point Audit Sub Point FAD Code FAD Hash ~~ 

Delete 
Sub Point

Or 
Post Office FAD Code 

Clear i 
r 

W 

E tints 
Include Events (- I S!

Figure 15 - Update Audit Points or FAD Code 

This form allows for the selection of Audit Point and Audit Sub Point pairs, or for the identification of the 
required Audit Point and Sub Point based upon the Post Office FAD Code. 

To select an Audit Point/Sub Point directly: 

Select the required Audit Point from the Audit Point drop down list. 

Optionally, select the required Audit Sub Point from the Sub Point drop down list. 

Click on the 'Add' button. 

If no Audit Sub Points are explicitly selected, all Audit Sub Points for the selected Audit Point will be 
added. 

To select an Audit Point/Audit Sub Point based upon the Post Office FAD Code: 

Enter the FAD Code in the Post Office FAD Code box. 

Click on the 'Add' button. 

The extract date range will be used to identify all active transaction data Sub Points for the specified 
FAD Code. 

If the 'Include Events' checkbox is checked, a dialogue is shown advising the user that Event Audit 
Points and Sub Points will be added to the list of selected audit points (see figure 16). 
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To add _selection criteria Select Audit Point and Sub Point or input Pot 17tfice FAD Code, then click 'Add'. 

To remove selection criteria: Select criteria in hat. then click 'Delete'. 

L i:it of :eleGed.'.udit F'cint 5eler_tiir, Lrirt,=ria 
New /alue:i. •______....__ .... ....... ..._....—.........~... ._..._.......~... .... 

kdd  4udit Point Audit Sub Point ;FAG Cade ADHachM'Audit Point  -_. 

TMS  — — TMS L lu,ter1E 
< Qetete 

Sub Point x1 

Cluster1 B

r 
Event rnessage Audit Points and Sub Points will be added to the list, 

O • 

OK  cancel i 

Clear 

In_ludeEvents

I r 

Figure 16 — Add Events Audit Points message box 

If the user clicks 'OK' the list of Audit Points/Sub Points will be updated with the Events Audit Points/Sub 
Points applicable to the selected TMS or BRDB audit points. 

Audit Points/Sub Points can be removed from the list of selected audit points by highlighting the entries 
in the list and clicking the 'Delete' button. The Events Audit Points/Sub Points can be removed by 
unchecking the 'Include Events' checkbox. 

Once all of the required Audit Point/Audit Sub Points have been selected, the user can click on the 'OK' 
button to return to the Specify Selection Criteria form. 

8.5.3.2 Select PAN 
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Input - PAN and Type 
Enter PAN 

Entry Type r Clear 
F_ 

Hashed 
(Tick as Required)

Display - PAN Details 

PAN 

Hashed PAN 

Displayilnpuk File Retrieval Templates Required 

Horizon Template 

HNG X Template 

OK j Cancel j 

Figure 17 - Select PAN form 

This form allows the specification of Audit File selection criteria in the form of two templates which will 
be applied to Horizon and HNG-X Audit File names respectively. 

The user: 

1. Enters either a clear or hashed PAN in the 'Enter PAN' box. 

2. Selects the type of PAN entered using the 'Entry Type' checkboxes. 

3. Clicks the 'Generate' button. 

If a clear PAN was entered, the 'PAN', 'Hashed PAN', 'Horizon Template' and 'HNG-X Template' fields 
will be populated. 

If a hashed PAN was entered, only the 'Hashed PAN' and 'HNG-X Template' fields will be populated. 

The user then clicks the 'OK' button to accept and use the generated templates. 

Actions performed via this dialogue are recorded for internal audit purposes (see DEV/APP/SPG10016 — 
Audit Extraction Client Support Guide for details). 

8.5.4 Mai t i 
This form allows the management of an ARQ once the initial extract details have been specified 
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The form provides the following views: 

ARQ Details 

Overview of actions performed on the ARQ. 

Retrieval Criteria 

Retrieval Criteria applied for Audit File extraction. 

Audit Files 

Audit Files currently selected for extraction and extraction status. 

Filtering 

Specifies filtering of Audit File contents. 

Validation and Query 

Results of filtered data validation and application of query. 

Presentation 

Export results to Excel files. 

It should be noted that the available views will depend upon the type of data being extracted and the 
current stage of the analysis. Initially only the ARQ Details, Retrieval Criteria and Audit Files tabs will be 
available. 
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ARQ Reference OTH32358 Requestor !Other 3rd Patty 
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Extract Status New:Criteria0rdy 
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ARQ Actions
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Figure 18 - Maintain ARQ form - ARQ Details tab 

This view is for information only. 

It displays the actions that have been performed on the ARQ to date. 

Clicking on the 'View Actions' button displays the list in a separate form. 

The 'Extract Status' and 'Abstraction Status' values are described in DEV/APP/LLD/0071 — Audit Data 
Retrieval Low Level Design. 
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Figure 19- Maintain ARQ form - Retrieval Criteria tab 

This tab provides a view of the currently applied Audit File selection criteria, and a description of any 
limitations the selection will place upon additional filtering. 

The `Select' button is greyed out as this is a read-only view. In order to amend the selection criteria, the 
user must click the 'AMEND Criteria' button which will cause the 'Specify Selection Criteria for Query' 
form to be displayed (see section 8.5.3). Note that the Date range selection criteria can not be amended 
if a Post Office FAD code was used in the original selection criteria. 

A short description of the data which will be retrieved is shown to the left of the Amend Criteria button. 
This indicates the type of filtering (and subsequent analysis) that will be available using the current 
retrieval criteria. 
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ARQ Details Retrieval Criteria Audit Tracks , 
if

Files Names for ARQ Reference OTH32358

Filename Size Status 
FNIJ1 BRDEE:_ UD B ,AUDiIT20090319039001 20090720_ 05351.. . 90406 Requested 
FN01_BRDB_AI_ID_B_AUDIT20090319039001 20090512_08530.. . 90406 Requested 
FN01 RDB_AUD AUDIT20090319017001_20090720_05352... 8464 Requested 
FN0J1_BRDB_AUD_B_AUDIT2009031901700120090512_08530. . 8864 Requested 

Files Found 4 Select All I 
No of Files Selected 4 
Size of Selected Files 349 36 Kb 

Selected File List Contol 

{ RESTORE Files ( REPLACE Files ContirrnSe s DELETE Files 

Refresh View Close 

Figure 20 - Maintain ARQ form — Audit Tracks tab 

This view displays the currently selected list of Audit Files and their statuses. 

The user can select some or all of the Audit Files in the file list and then perform the following actions: 

Restore Files 

This action restores all of the currently highlighted Audit Files from the Eternus to the Audit 
server. 

Replace Files 

This action updates the file list, retaining only the highlighted files. 

Confirm Seal Status 

This action performs a seal check for the highlighted Audit Files. It should be noted that seal 
checking is performed automatically when Audit Files are retrieved. 
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Delete Files 

This action removes the highlighted files from the file list. 

All Audit Files remaining in the list must be successfully retrieved and seal checked in order to progress 
the ARQ through to filtering and to ensure that the final report on the ARQ contains only those Audit 
Files that were used in the analysis. 

8. .4 Filtering 

The Filtering tab is enabled once all the selected Audit Files have been retrieved. 

Filtering can be applied to all Audit data irrespective of the source. For example, if an ARQ results in 
both Horizon and HNG-X data being returned, applying the filter will result in both data sets being 
filtered. 

Two types of filtering are available: 

1. By date and FAD code. 

This type of filtering is applied when the retrieved Audit Files contain exclusively message-based 
data. This can be either Horizon (TMS) or HNG-X (BRDB) data. 

If any of the Audit Files to be filtered contain non-message data, this type of filtering is not 
available. 

2. By free-format string. 

This type of filtering is applied when the retrieved Audit Files contain non-message data or a 
mixture of message and non-message data. 

If the Audit Files contain exclusively message-based data, this type of filtering is not available. 

The type of filtering that is available will depend upon the sources of the Audit File data. As the Audit 
File data type is related to the Audit Sub Point under which the data was gathered, an indication of which 
filtering type will be used is displayed on the Retrieval Criteria tab when the Audit Point selection criteria 
are specified. 

When applying a free-format string filter, the output type can be specified as 'FILE' or 'ABSTRACT'. 

Filtering with an output type of 'FILE' will result in the complete file (including non-matching items) being 
included in the output if the file contains any item matching the specified filter. 

When 'ABSTRACT'' is specified as the output type, only those items matching the filter criteria will be 
included in the output. 

Message data filtered by date and FAD code will always be abstracted. 
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Sage Filter I Apply Filter 

Refresh View Close 

Figure 21 - Maintain ARQ form — Filtering tab (Message based) 

This type of filtering is applied to exclusively message-based data (either TMS or BRDB) and is only 
available when all Audit Sub Points selected on the Retrieval Criteria tab contain only message data. 

Filtering based upon message date and FAD code is possible. 

The FAD code to be included in the filter must be added to the FAD list using the 'Add' Button. Only one 
FAD code can be added at this release. 

Once the date range and FAD list have been completed the filter can be saved and applied. 

Note that if Post Office FAD codes were specified in the original selection criteria, the FAD List is 
populated with these values and they can not be removed. In this situation there is no point in adding 
further FAD codes as it is unlikely that the relevant data would have been retrieved. 
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D elet.r, 
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j 

Refresh View 
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Figure 22 - Maintain ARQ form — Showing View Abstraction Errors button 

If any errors occur during the application of the filter an appropriate message will be displayed in the 
status bar of the Filtering tab and the 'View Abstraction Errors' button will appear (see figure 22). 
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Figure 23 - Abstraction Errors form 

POST 
OFFICE 

If the View Abstraction Errors' button is clicked, the Abstraction Errors form (figure 23) will be displayed 
showing details of the errors. 
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ARQ Details I Retrieval Criteria I Audit Tracks Filtering 

Output Type 

FILE - Complete file (including non-snatching rows) containing matching data 
ABSTRACT - Gnly those rovas that match the selection criteria 

Free format String Add 
J  

Add PAP! 
j 

Delete 

Save Filter Apply Filter 

Refresh View j Close + ~I 

Figure 24 - Maintain ARQ form — Filtering tab (Text based) 

Text data filtering will be used where the Audit Sub Points specified on the Retrieval Criteria tab contain 
either non-message data or a mixture of message and non-message data. 

Free format text strings are added to the filter list using the Add' button, and may be removed by 
highlighting the required item and clicking on the 'Delete' button. 

PAN values in clear, encrypted and hashed form may be derived from the PAN Generation dialogue 
(see section 8.5.4.4.3) which is accessed via the Add PAN' button. 

Once all the filter criteria have been specified, the filter can be saved by clicking on the 'Save Filter' 
button and applied by clicking on the Apply Filter' button. 

When more than one string or PAN has been specified, a match is found if an item contains any one of 
the specified string or PAN values i.e. the values are 'OR'ed together for the search. 

NOTE: String searches are case sensitive. 
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Figure 25 - Maintain ARQ - Text Based filtering - PAN Dialogue 

POST 
OFFICE 

The PAN Generation Dialogue allows for the generation of the following PAN combinations: 

PAN Input Type Output PAN Type 

Clear Hashed 

Encrypted Clear and Hashed 

If the only PAN type available is hashed, no conversion is possible. 

It is not possible to generate an encrypted PAN. 

Actions performed via this dialogue are recorded for internal audit purposes (see DEV/APP/SPG/0016 — 
Audit Extraction Client Support Guide for details). 

8545 Validation and Query 

This tab will only be available if the followina conditions have been met 
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1. The retrieved data consists exclusively of TMS and/or BRDB messages. 

2. Filtering has been performed. 

Horizon and HNG-X transaction data have different formats. In addition, message sequences across the 
transition from Horizon to HNG-X will be non-contiguous. For these reasons, the validation, querying and 
presentation steps must be applied separately for the two data sources. 

The data source is selected on the Validation and Query tab and, once selected, activates the Sequence 
Validation, Select Query and Execute Query sub-tabs. 

Selecting the data source will also cause the message sequence and sequence gap information to be 
displayed on the Sequence Validation sub-tab. 

8.5.4.5.1 Sequence Validation 

AR Details 1 Retrieval Criteria Audit Tracks I Filtering Validation and Query 

Data Sajt,!(C? 3tatU3 COnCatEYlatIOYI eted 

Sequence Validation I Select Query Execute Query l 

Node Lovnest Message ~~age 
342432 .1 2708185 2708400 
342432::2 1186095 1186102 
342432::3 

_ 
ii 51:34232 5134441 

342432::4 L 4938959 4940012 
342432:5 f 4770109 4771443 
342432::6 3937287 3938447 
342432:32 1 398506 398540 
342432:52 L 274266 274300 
342432::53 225003 F  225035 

OAF'S- NONE 

DUPLICATES - NONE 

He e.Ii to Lb 

Figure 26 - Maintain ARQ form - Validation and Query tab - Sequence Validation 

TMS and BRDB messages are numbered in sequence for each node. During filtering any retrieved audit 
message data is analyzed to determine what message sequences are present in the data and whether 
there are any gaps or duplicates in those sequences. A gap in a message sequence may indicate that a 
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message is missing from the audit data. Duplicates may indicate that an audit file has been gathered 
twice. 

The Sequence Validation sub-tab displays details of the message sequences and highlights any gaps or 
duplicates found during filtering. 

Sequences and sequence gaps are organised on a FAD::Node basis. 

When no gaps or duplicates are found, the form will be similar to that shown in Figure 26 with the text 
'GAPS — NONE' and DUPLICATES — NONE' displayed. 

GAPcFUUN1 
342432:1 2708246 2708400 J Isho' n red) 
342432::I 2708341 2708341 
342432-1 2708342 2708343 

2708342 2708342 DUPLICATES FOUND342432•.1 
.1 42432 2708o3 35 2708 59 5 (shown in blue) 

Tj _ 
342432 ..1  27CI8366 270830 f {
342432::2 1186101 1186102 
342432.:3 1 5134436 5134441
342432::4 
342432::4 
342432::5 
3424?2-5 

4939158 
4939600 
4770713 
4771171a 

4939720 
4939632 
4771138 
47711?R 

SEEK SSIST Itr'E 1 

AUDIT 3UF`'PORT 

_~ f _i 

Refresh View Close 

Figure 27 — Maintain ARQ form — Validation and Query — Gaps and Duplicates found 

When gaps are found, the gaps are shown in red in the message sequence list and the text 'GAPS 
FOUND' is displayed, together with the text 'SEEK ASSISTANCE FROM AUDIT SUPPORT'. 

When duplicates are found, the duplicates are shown in blue in the message sequence list and the text 
`DUPLICATES FOUND' is displayed, together with the text 'SEEK ASSISTANCE FROM AUDIT 
SUPPORT'. 

Figure 27 shows the form when both gaps and duplicates are found. 
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AARO Details I Retrieval Criteria I Audit Tracks I Filtering Validation and Query

Data Source 11at' _.1 Status 1Corraterah r completed 

Sequence's alidation Select 5uery l E..ecute i uery I 

Node Luw~ t p.4e^<u C Higiie t t+a:; 3~0 SAFE t101`1E 

DI_IF'i I_: TF 3 NONE 

Refresh View l Dole 
.._..,...__.-.......__.....__.._-__...3 _-._.._......_......__...... ..... ..._,.,_.. 

Figure 28 — Maintain ARQ form — Validation and Query — No messages found 

In the event that no messages are identified during filtering the only output displayed will be "GAPS - 
NONE" and "DUPLICATES — NONE" as shown in Figure 28. 

8.5.4.5.2 Select Query 
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X, 
ARQ Details I Retrieval Criteria I Audit Tracks J Filtering 'Ii alidatlon and IJue,'y I 

Data Source J HNG-X j Status jConcatenation completed 

Sequence Validation ;,..Select Query;, Execute Query 
;elect Re — ~......_. _. qurced Query __ 

Q~.rery 

Retrieve I 
_____2  

— 
__ ____1

SaVe4. 

Retre:h:'ieav i_loe

Figure 29 - Maintain ARQ form - Validation and Query tab - Select Query 

The Select Query sub-tab enables the selection of the query to be applied to the selected data source. 

If both Horizon and HNG-X data sources exist within the ARQ, each data source will require a query to 
be selected and progressed independently. 

The first time the Select Query sub-tab is accessed for an ARQ data source, no query will be shown. 

Subsequent returns to this tab will show the selected query. (The selected query will have been saved in 
the sub-directory for the ARQ within the F:\USERAREA directory on the archive server. By saving the 
queries in the ARQ directory we allow for amendments to be made to standard queries which will only 
affect the current ARQ.) 

Standard queries may be retrieved by clicking on the Retrieve button and displaying the Available 
Queries dialogue. 
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xj 
Sequence Val 

Select. Requ Selected ~H IOP.xgl 
Query _ ~.... 

I Available Queries 
H x_AuthCds. xgl 
Hx_BQIOPPANBaicodes•xgl 1 e As 
H x_B ureau. xql - - -a 

r - -- — Hx Event:' xol 

Hx10PMLabel.xgl 
Hx 10PPANBarcudo;;.igl 
Hx MailSer: ire ;.:ql 
Hx MailSerrice'aDr.ddress.xgl 
Hx MissingDay.xgl 
Hx_RemittancePoucheo, xq: 
H x_S ecurit-YE'.,ents. xql 

5eIar- 
j Cancel j 

Close 

Figure 30 - Maintain ARQ form - Validation and Query tab - Select Query - Available Queries 

The Available Queries dialogue (see figure 30) lists all of the queries available at the Audit server to 
which the ARQ has been directed. 

A Query can be selected by clicking on the query in the Available Queries list and, once it is shown as 
selected, clicking on the Select button. 

The Available Queries dialogue will be removed, and the selected queries details used to populate the 
Query box on the Select Query tab. 

At this point, the query has been selected, but has not been assigned to the ARQ data source. This 
doesn't happen until the Query is executed. 

The Open button must be clicked to load the query into the query text box. 

If amendments to the standard query are required, double clicking on the query text box will display an 
editable query dialogue. 

Amendments may be saved to the original standard query in the CommonQueries server directory, or to 
a new Common query by clicking on Save or Save As respectively. 

It is important to remember that these two buttons act upon the Common Queries and have no impact 
upon the ARQ itself. 
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Figure 31 - Maintain ARQ form - Validation and Query tab - Select Query (Populated) 

The contents of the Query Text box must now be applied to the ARQ data source. 

This occurs every time the query is executed, and ensures that the query displayed on screen at the time 
of query execution matches what is actually applied. 
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Refresh View i Close 

Figure 32 - Maintain ARQ form - Validation and Query tab - Execute Query 

Before submitting the query for execution a check is performed against the size of the data file to be 
queried. 

If the file exceeds 200Mb a warning that the file may be too large to query will be displayed. The user 
may choose to proceed, or cancel the action. 

If the option to proceed is selected, and the file subsequently proves too large for querying, it will be 
necessary to close the ARQ, produce a number of ARQs using smaller date ranges to satisfy the request 
and separately filter each of the new ARQs. 

Progress of query execution at the server is displayed in the Execute Query action list. 

If the query results in an output file, the presentation tab will be activated. 

(Note there is no check to prevent the user selecting the Execute Query sub-tab and attempting to 
execute a query before a query has been selected. In this case, a message box is displayed with the 
message Unable to validate as no Query loaded'.) 
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A set of predefined queries will be maintained on both Audit servers. These queries implement the 
queries that were available under Horizon in the FLoWR query language. 

There are two versions of each query file: one for Horizon and one for HNG-X. The file name for the 
Horizon query begins with the letters 'Hz' and that for the HNG-X query begins with 'Hx'. 

H[xz]_AuthCds.xgl Query based upon the IOP query which also shows 
banking agent response information. 

H[xz]_BQIOPPANBarcodes.xgl Query based upon the IOP query which also shows 
any banking agent C2 messages, PAN and client 
account references. 

H[xz]_Bureau.xgl Query based upon the IOP query which also shows 
details of Bureau transactions. 

H[xz]_Events.xql Basic events query. Shows all counter events 
generated at a branch. 

H[xz]_Events_Num.xgl As H[xz]_Events.xql but includes the JSN (Num for 
Riposte) too. Note that Hx_Events_Num.xgl was 
modified for CP 1913 to include a poid column as 
described in section 8.5.4.5.3.6 "Hx_Events_Num.xgl". 

H[xz]_IOP.xgl Basic branch transactions query. Shows basic 
information on transactions recorded at a branch. 

H[xz]_IOP_DEST_SRC.xgl As H[xz]_IOP.xgl but omits the "reversal" attribute. 

H[xz]_IOP_Num.xgl As H[xzLIOP.xgl but includes the JSN (Num for 
Riposte) too. 

H[xz]_IOP_TITO.xgl As H[xz]_IOP.xgl but includes transfer in/out 
information if present. 

H[xz]_IOPDVLA.xgl Query based upon the IOP query which also shows 
even more additional information relating to DVLA 
transactions than H[xz]_IOPDVLA.xgl. It does not 
restrict those transactions shown to be DVLA related 
as H[xz]_IOPDVLA.xgl does. 

H[xz]_IOPDVLAAdditionai.xgl Query based upon the IOP query which also shows 
additional information relating to DVLA transactions. 

H[xz]_IOPMLabel.xgl Query based upon the IOP query which also shows 
additional information relating to Mails labels. 

H[xz]_IOPPANBarcodes.xgl Query based upon the IOP query which also shows 
additional information relating to Pan and client 
account references. As of release 17.58 this query was 
enhanced with an additional field — see section 
8.5.4.5.3.11 "Hx_IOPPANBarcodes" on page 55 for 
details. 

H[xz]_IOPPouchld.xgl Query based upon the IOP query which also shows the 
pouchld. 
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H[xz]_IOPMailService.xgl Query based upon the IOP query which also shows 
additional information relating to Mails service 
transactions. 

H[xz]_IOPMailServiceSDAddress.xgl Query based upon the IOP query which also shows 
additional information relating to the destination 
address of Mails transactions. As of release 17.58 this 
query was enhanced with additional fields — see 
section 8.5.4.5.3.10 "Hx_IOPMailServiceSDAddress" 
on page 55 for details. 

H[xz]_IOPMailServiceSDAddressWithExtraAddresses.xq Hz IOPMailServiceSDAddressWithExtraAddresses.xq 
I I is identical to Hz_IOPMailServiceSDAddress.xgl. 

Hx_IOPMailServiceSDAddressWithExtraAddresses.xq 
I outputs in its spreadsheet some extra columns over 
and above Hx—IOPMailServiceSDAddress.sgl which 
are shown in section 8.5.4.5.3.1. 

H[xz]_RemittancePouches.xgl Query which shows the barcodes of all remittance 
pouches delivered to, or collected from a branch. 

H[xz]_SecurityEvents.xgl Query based upon the Events query which also shows 
additional security information. 

H[xz]_Signons.xgl Query based upon the Events query which only shows 
details of sign-ons & signoffs. 

H[xz]_StockDeclarations.xgl Query which shows details of all stock declarations 
made at a branch 

H[xz]_JSN.xgl This query is mainly of significance for Hx_JSN.xgl 
though Hz_JSN.xgl has been designed to be similar. 
For Hx_JSN.xgl it makes a point of outputting all 
JSNs. For any counter JSNs are unique and there are 
no gaps in the sequence of them. 

More details of Hx_JSN.xgl are shown in section 
8.5.4.5.3.2. More details of Hz_JSN.xgl are shown in 
section 8.5.4.5.3.3. 

H[xz]_POID.xgl Hz—POID.xql just produces a spreadsheet with "POID 
never supported in Horizon" in an Info column. 
Hx_POID.xgl is described in section 8.5.4.5.3.4 
"Hx_PO I D.xq l". 

H[xz]_Poid_User.xgl Hz_Poid_User.xgl just produces a spreadsheet with 
"POID never supported in Horizon" in an Info column. 
Hx_Poid_User.xgl is described in section 8.5.4.5.3.5 
"Hx_Poid_User.xgl". 

H[xz]_IOPPANBarcodesWithPaymentCode.xql These queries are copies of 
H[xz]_IOPPANBarcodes.xgl with an additional column 
for the "Method of Payment". Full details are given in 
sections 8.5.4.5.3.7 and 8.5.4.5.3.8. 

H[xz]_Pouches.xgl Hz_Pouches.xgl just supplies a line "This query is not 
yet supported in Horizon". Hx_Pouches.xql is 
described in section 8.5.4.5.3.9. 

H[xz]_BranchTradingStatement.xgl Hz_BranchTradingStatement.xgl just produces a 
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spreadsheet with "trading statements are not available 
for Horizon yet" in an Info column. 

Hz_BranchTradingStatement.xgl is described in 
section 8.5.4.5.3.12 
"Hx_BranchTradi ngStatement.xq I". 

H[xz]_BFwdandCFwd.xgl Hz_BFwdandCFwd.xgl just produces a spreadsheet 
with "'rollover figures not available for Horizon yet" in 
an Info column. 

Hx_BFwdandCFwd.xgl is described in section 
8.5.4.5.3.13 "Hx_BFwdandCFwd.xgl". 

8.5.4.5.3.1 Hx IOPMailServiceSDAddressWithExtraAddresses.xql 

These are the extra columns Hx_IOPMailServiceSDAddressWithExtraAddresses.xql produces over and 
above Hx_IOPMailServiceSDAddress.xgl. 

Hx_IOPMailServiceSDAddressWithExtraAddresses.xlsx 
column header 

Contents from XML 

VDestina.Address. Premises $tt/Message/DataNDestina/Address/Premises 

VDestina.Address. PostcodeZip $tt/Message/DataNDestina/Address/PostcodeZip 

TandT.Control.Source. Name $tt/Message/Data/TandT/Control/Source/Name 

TandT.Control .Source.Add 1 $tt/Message/Data/TandT/Control/Source/Add1 

TandT.Control.Source. Postcode $tt/Message/Data/TandT/Control/Source/Postcod 
e 

where $tt is the trackAndTraceMessage "Entry Name" directive value of the PSAAccountingLine 
element. 

8.5.4.5.3.2 Hx JSN.xgl 

These are all the columns in Hx_JSN.xgl. 

Hx_JSN.xlsx 
column header 

Contents from XML 

RequestType node-name($s) 

Branchid $s/RequestHeader/Branchld 

Counterld $s/RequestHeader/Counterld 

JSN $s/RequestHeader/JournalSegNumber 

TimeSent $s/RequestHeader/TimeSent 

Userld $s/RequestHeader/Userld 

Serviceldentifie 
r 

$s/Serviceldentifier 

Session Id $s/Dyno/directive:Entry[@Name='basketHeader']/BasketHeader/directive:Entry[@Name='ssn']/Lon( 
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This report is ordered by CounterlD and JSN. 
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This report is intended to output all JSNs. However the actual code logic that checks that no JSNs are 
missing or duplicated checks the JSN in the "Request Header" which is outside of the XML returned and 
processed in these queries. If the JSN was in this `Request Header" but missing from the JSN field of 
the XML above it would not appear. 

8.5.4.5.3.3 Hz JSN.xgl 
These are all the columns in Hz_JSN.xgl. 

Hz_JSN.xlsx column header Contents from XML 

Groupld $s/Groupld 

Id $s/ld 

Num $s/Num 

Date $s/Date 

Time $s/Time 

TxnData.SessionId $s/TxnData/Sessionld 

where $s is the message. 

This report is ordered by Id and Num. 

8.5.4.5.3.4 Hx POID.xgl 
These are all the columns in Hx_POID.xgl. 

Hx_POID.xlsx column header Contents from XML 

Counterld $s/RequestHeader/Counterld 

JSN $s/RequestHeader/JournalSeqNumber 

TimeSent $s/RequestHeader/TimeSent 

Userld $s/RequestHeader/Userld 

Poid $s/RequestHeader/Poid 

RefDataVersion $s/RequestHeader/RefDataVersion 

Service Identifier $s/Serviceldentifier 

Token Id $s/RequestHeader/Tokenld 

TrainingMode $s/RequestHeader/Training Mode 

where $s is the top level GenericRequestDTO element and $s/RequestHeader/Poid exists. 

The report is ordered by Counterld and JSN (as integers). 

8.5.4.5.3.5 Hx Poid User.xgl 
These are all the columns in Hx_Poid_User.xgl. 

Hx Poid User.xlsx column header Contents from XML 
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Counterld $s/RequestHeader/Counterld 

JSN $s/RequestHeader/JournalSegNumber 

TimeSent $s/RequestHeader/TimeSent 

Userld $s/RequestHeader/Userld 

branchUser $s/Dyno/directive:Entry[@Name='branch User'] 

firstName 

lastName 

$s/Dyno/directive: Entry[@Name='firstName'] 

$s/Dyno/directive:Entry[@Name='IastName'] 

userRole $s/Dyno/directive:Entry[@Name='userRole'] 

stockUnit $s/Dyno/directive: Entry[@Name='poid'] 

poid $s/RequestHeader/Counterld 

globalUser $s/Dyno/directive: Entry[@Name='global User'] 

where $s is the top level GenericRequestDTO element and $s/Service Identifier = 
"eu m/CreatePOIDUser". 

The report is ordered by Counterld and JSN (as integers). 

8.5.4.5.3.6 Hx Events Num.xgl 

This was modified for CF 1913 to output a poid column. 

The logic for this column is — 

if (exists($req/Poid)) 

then 

<Poid>{data($req/Poid)}</Poid> 

else 

( 

if (contains($poid,'POID')) 

then 

<Poid>{data($poid)}</Poid> 

else 

<Poid></Poid> 

so there may either be a poid from the poid user creation message or from the second logon message. 

where $req is the top level RequestHeader element and $poid= 
$s/directive:Entry[@Name='eposAdditionaI Data'] where %s is the item in the MessageList of the 
AuditData being processed. 
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8.5.4.5.3.7 Hx IOPPANBarcodesWithPaymentCode.xql 
These are the extra columns Hx_IOPPANBarcodesWithPaymentCode.xql produces over and above 
Hx_I OPPANBarcodes.xgl. 

Hx_IOPPANBarcodesWithPaymentCode.xls 
x column header 

Contents from XML 

PaymentCode {data($x/directive: Entry[@Name='paymentCode']/Integer) 
} 

$x can be any of $s//EpossAccountingLine , $s//BankingAccountingLine, $s//DCSAccountingLine, 
$s//APAccounti ng Line, $s//PSAccountingLine, $s//PS2ndaryAccounti ng Line or $s//ForExAccountingLine) 

where 

$s is any GenericRequestDTO. 

The possible values of PaymentCode are defined in associated document "HNG-X HLD - Settlement 
Functions". 

Version 11.0 of that document gives — 

This defines the Method of payment declared as part of the AP Transaction. 

Value Meaning 
1 Cash 
2 Cheque or Ch /Cash 
3 Saving Stamps included 
4 Debit Card or Debit! Credit Card 

8.5.4.5.3.8 Hz /OPPANBarcodesWithPaymentCode.xql 
These are the extra columns Hz_IOPPANBarcodesWithPaymentCode.xql produces over and above 
Hz_IOPPANBarcodes.xgl. 

Hz_IOPPANBarcodesWithPaymentCode.xlsx 
column header 

Contents from XML 

EPOSSTransaction.AdditionaIData.MoP data($x/EPOSSTransaction/AdditionalData/MoP) 

$x is any Message 

8.5.4.5.3.9 Hx Pouches_xgl 
These are all the columns in Hx_Pouches.xgl. 
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Hx_Pouches.xis 
x column header 

Contents from XML 

Counterld $s/RequestHeader/Counterld 

JSN $s/RequestHeader/JournalSegNumber 

TimeSent $s/RequestHeader/TimeSent 

Userld $s/RequestHeader/Userld 

RefDataVersion $s/RequestHeader/RefDataVersion 

Service Identifier $s/Serviceldentifier 

Token Id $s/RequestHeader/Tokenld 

TrainingMode $s/RequestHeader/Training Mode 

accBarcode $s/Dyno/directive:Entry[@Name='basketHeader']/BasketHeader/directive: 

Entry[@Name='optionalData']/Optional Data/directive: Entry[@Name='accBarcode']/Stri n 
9 

pouch Data $s/Dyno/directive:Entry[@Name='basketHeader']/BasketHeader/directive: 

Entry[@Name='optionalData']/OptionalData/directive: 

Entry[@Name='pouch Data']/MessageList/String) 

where $s is the message which must start GenericRequestDTO and lines are included only if the 
accBarcode is not blank. 

The report is ordered by first Counterld and then within that JSN. 

8.5.4.5.3.10 Hx IOPMailServiceSDAddress 
As of release 17.58 this query was enhanced with the following additional fields. 

Hx_IOPMailServiceSDAddress.xlsx 
column header 

Contents from XML 

FirstLineOfAddress data(fn:replace($x/directive:Entry[@Name='nrtData']/nrtdata/NrtMessage 
, " ( A . * <Addressl>([ A<]*)</Addressl>. * $I A.+$)" "$2" "s")) 

CertificateOfPostinglssuedYorN data($x/directive:Entry[@Name='coplssued']/Boolean) 

CustomerReference data($x/directive:Entry[@Name='customerReference']/String) 

DestinationPostCode data($x/directive:Entry[@Name='destinationAddress']/String) 

where $x is the settlement message — the full query needs to be looked at for details. 

8.5.4.5.3.11 Hx IOPPANBarcodes 

As of release 17.58 this query was enhanced with the following additional field. 

Hx_IOPPANBarcodes.xlsx column 
header 

Contents from XML 

CustomerReference data($x/directive: Entry[@Name='customerReference']/Stri ng) 

where $x is the settlement message — the full query needs to be looked at for details. 
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8.5.4.5.3.12 Hx Branch TradingStatement.xql 
This query outputs the following fields. 
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Hx_BranchTradingStatement.xlsx 
column header 

Contents from XML 

Time data($s/RequestHeader/TimeSent) 

(dent data($sv) 

RolloverReport data($s/Reprint/ReportData)) 

where $s is any RollBranchRequestDTO and $v is $s/Service Identifier. 

The report is ordered by the first "Time" column. 

The RolloverReport gives all the data from the Branch Trading statement in a special print format. One 
way to make the data in each cell more legible is to select the cell with data in, press Cntrl Home, Cntrl 
Shift End, Cntrl C and then paste the output into notepad. 

8.5.4.5.3.13 Hx BFwdandCFwd.xgl 
This query outputs the following fields. 

Hx_BFwdandCFwd.xlsx column Contents from XML 
header 

Time data($s/RequestHeader/TimeSent) 

(dent data($sv) 

SO (fn :replace(data($s/Repri nt/ReportData), 
".*<ifnotreprint>\s<space x= [0-9]* />[0-9:\s/]*\s<space 
x=[0-9]* />TP:\s<space x= [0-9]* />([0-9]*)\s<space 
x=[0-9]* />BP:\s<space x= [0-9]*""/>([0-9]*)\s<space 
x=[0-9]*""/>SU:\s<space 
9]*)\s<nl/>\s.*" "$3" "s")) 

TP (fn: re place (data ($s/Re pri nt/Re portData), 
".*<ifnotreprint>\s<space x= [0-9]* />[0-9:\s/]*\s<space 

:\s<space x= [0-9]* />([0-9]*)\s<space 
x=""[0-9]* />BP:\s<space x= [0-9]*""/>([0-9]*)\s<space 
x=[0-9]* />SU:\s<space 
9]*)\s<nl/>\s.*" "$1" "s")) 

BP (fn :replace(data($s/Repri nt/ReportData), 
".*<ifnotreprint>\s<space x= [0-9]* />[0-9:\s/]*\s<space 
x=[0-9]* />TP:\s<space x= [0-9]* />([0-9]*)\s<space 
x=[0-9]* />BP:\s<space x=""[0-9]*""/>([0-9]*)\s<space 
x=[0-9]* />SU:\s<space 
9]*)\s<nl/>\s.*" "$2" "s")) 

BFwd (fn :replace(data($s/Reprint/ReportData), ".*Balance 
B/Fwd\s&lt;space x=""[0-9]* /&gt;(-?[0-9.]*-?).*" "$1"

CFwd (fn :replace(data($s/Repri nt/ReportData), ".*Balance 
C/Fwd\s&lt; space x= [0-9]* /&gt;( ?[0-9.]*-?).*" "$1"
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where $s is any RolloverSUBPRequestDTO or RoIISURequestDTO and $v is $s/Service Identifier. 

The complex expressions for SU, TP, BP, BFwd and CFwd are designed to return the stock unit name, 
Trading Period, Balance Period, brought forward figure and carried forward figure for the stock unit 
rollover reports. 

The report is ordered by the first "Time" column. 

This report can be used to check that brought forward and carried forward figure match as follows. 

Break the period you want for a given office into contiguous periods and run FASTARQs for each using 
the new report Hx_BFwdandCFwd. I have found 4 months works fine for one of the contiguous periods. 
A bigger number of months can be tried. There will be a limit at some point. 

Rename the spreadsheet with the very oldest data Hx_BFwdandCFwd.xlsx Hx_BFwdandCFwdFull.xlsx. 

Then open progressively less and less old Hx_BFwdandCFwd.xlsx s and copy the data and paste it to 
the bottom of Hx_BFwdandCFwdFuli.xlsx. It is essential this is done correctly since each spreadsheet is 
in time order and we want to preserve this. 

Now select all the data in the report (leave the headings etc.) and do Home Sort by column C (the stock 
unit). 

Now select the empty column H, right click, Format Cells and select General. This step is essential to 
make the formula work. 

Now copy the following formula 

=IF(C10=C9,IF(G9<>F10,"Discrepancy","OK"),'Different SU") 

into cell H9. 

Now copy cell H9 and paste it into all the column H cells below it which have data to the left. 

Now visually check row H and confirm it only has OK or Different SU in. Alternatively copy all of row H 
and paste it into notepad and search notepad for the word Discrepancy and make sure none are found. 

When executing multiple queries, the validation step (see section 8.5.4.5.1) must be performed for each 
data source in an ARQ, and the querying and presentation steps (see sections 8.5.4.5.2 and 8.5.4.6) 
must be performed for each query for each data source. 

The recommended approach is to process each query for each data source through to presentation 
before starting the next. 
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JJ Maintain ARC: OTH303B on RE 11 ;Bi   

AR0 Details Retrieval Criteria i Audit Tracks Filtering f Validation and Query :,.,.Presentation; .. ............. 

Export Re._,It; to Excel 

r 

Export to Excel 

D:'F.eport.xLx 

Export Evert to Excel . . 

Refresh View Close 

Figure 33 - Maintain ARQ form — Presentation tab 

This form allows filtered message data and event data to be output to Excel 

Results may be targeted to a different location/file using the "Change" button adjacent to the required 
output file box. 

Once all required options have been selected, clicking the Create Output button instigates the creation of 
the required files. 

There is a limit in Excel 2013 32 bit of about a million rows per spreadsheet. To ensure that this is never 
exceeded when the number of rows is set to exceed 240,000 output is split across multiple worksheets. 

This number is a constant MAX_XL_ROWS in the audit client source. If it is found that it would be useful 
if this is increased it can be by request to the audit team. The maximum it can be set to would be around 
the million mark. It will take a moderate amount of work to test such a large number and make sure it 
works. 
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Filter Start Date Filter End Date Extra days for extraction FAD Code Include Events 

Select drive and folder for output 

f d [D.ATA] 

Queries to be run 

Figure 34 - Fast ARQ form 

This form is used to specify the search criteria and initiate a 'fast' ARQ. There are fewer options than 
with the 'slow' ARQ forms but, once started by clicking the 'Execute ARQ' button, the ARQ will proceed 
through the retrieving, sealing, filtering, querying and presentation steps without further user interaction. 

The Fast ARQ form can be displayed in three ways: 

1. Select 'Fast ARQ' from the File menu. 

When opened from the File menu, the Fast ARQ form will be displayed as in Figure 34. The 
Data Centre frame at the top of the form allows the selection of the data centre in which the new 
ARQ is to be created. 

2. Click the 'New fast ARQ' button in the toolbar. 
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When opened from the toolbar, the Fast ARQ form will be displayed as in Figure 34. The Data 
Centre frame at the top of the form allows the selection of the data centre in which the new ARQ 
is to be created. 

3. Right click on the required data centre and select 'Fast ARQ' from the drop down menu. 

When opened by right clicking a data centre, the Data Centre frame is not shown in the form as 
the data centre will automatically be set to the one which was clicked. 

Field Input Value Mandatory? 
!a 

Data Centre (if displayed) The data centre at which the ARQ is to be created. Mandatory 

Requester Select From: Mandatory 

Other 3 d̀ party 

Pathway IA 

Pathway Other 

Pathway SSC 

POCL IA 

POCL Other 

POCL Security 

Receipt Ref. ARQ Number, taken from the ARQ form. Mandatory 

Date Received The date the request was received. Mandatory 

Date Required The date the request is to be returned. Mandatory 

Filter Start Date Start date for which filtering should be applied. Mandatory 

Filter End Date End date for which filtering should be applied. Mandatory 

Extra days for extraction Number of days beyond the Filter End Date for Mandatory 
which audit files should be retrieved. 

(An Audit File may not be gathered until one or two 
days after it was created so adding extra days to 
the Filter End Date helps to ensure that all the 
required Audit Files are retrieved.) 

FAD Code FAD Code to filter on. Mandatory 

Include Events Checked if Event data is to be retrieved. Optional 

Select drive and folder for Specifies the location on the Audit Workstation Mandatory 
output where the final output files are to be copied. 

Queries to be run Specifies the queries that are to be run against the Optional 
audit data that has been retrieved and filtered. 

Output folder This is a read-only field that displays the selected 
output folder. 

After setting the selection criteria, the user can click the 'Execute ARQ' button to start the ARQ 
processing. If no queries have been selected, a message box is shown asking the user to confirm that 
they wish to continue (see figure 35). 
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[ 424 ,;._.̀  
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Select drive and fol~ dF' 
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{C 

} -J d: [DATA] 

-AAudit 
StandardDesk 

You have not selected any queries to be run, Do you want to continue? 

Yes

IDPDVLA 
IOPDV'LAAdditional 
IC PHailService 
IC PM ailS erviceS DAddres: 
I 16AAI

Figure 35 — Continue confirmation message box 

If the user clicks 'No', the message box closes and the user is returned to the Fast ARQ form to select 
one or more queries. If the user clicks 'Yes', the ARQ processing commences. 

When the ARQ completes, the message 'ARQ completed successfully' will be displayed in the status bar 
and the 'Close ARQ' and 'Exit ARQ' buttons are enabled. 

An Excel spreadsheet is created in the specified output directory on the audit workstation for each of the 
queries that have been executed. If events were included, a spreadsheet called Events.xls is also 
created in the output directory. 

(Note that if no queries were selected, there will be no Excel spreadsheets of message data created on 
the audit workstation since no queries were run. The files of filtered message data (Filteredhx.xml and 
Filteredhz.xml) will exist in the QUERY_AT\FINAL directory for the ARQ in the F:\UserArea on the audit 
server.) 

Clicking 'Exit ARQ' will close the Fast ARQ form but, if the ARQ has not been executed, a message box 
will be displayed requesting confirmation that the ARQ is to be exited (see figure 36). 
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Select drive and folder for output Queries to be run 
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~ I OPPP.hd Barcodes 

~ The ARO has not completed, ureau
Do you wish to close the Form? vents J udd 

[ StandaldDesk i PDVIA 
9r .es I No I
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IPMaiIS cry ice 

I O PM aIlS erviceS DAddress 
IOF'MLabel 
ICIPPANBarcodes 
I O PPouchl d 
IOP_TITO 
MailService 

Ouput folder

Execute ABQ 
I 

Exit ARO 

Figure 36 — Exit Fast ARQ confirmation message box 

Clicking 'Close ARQ' will display the Close ARQ form (see section 8.7). 
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L)3 er'rre 

Query Reference 

Access Reason

Files Narnes 

Files Found 0 Select All 
r 

o Files Selected. Fie 0
Size of Selected Files: 0 

Clo>e J 
Figure 37 - Close ARQ form 

This form is used to close an active ARQ. It may be opened in five ways: 

1. Select 'Close ARQ' from the File menu. 

When opened from the File menu, the Close ARQ form will be displayed with the 'Data Centre' 
frame at the top of the form as shown in figure 37. This allows the selection of the data centre 
from which the ARQ is to be closed. 

2. Click the 'Close ARQ' button in the toolbar. 

When opened from the toolbar, the Close ARQ form will be displayed with the 'Data Centre' 
frame at the top of the form as shown in figure 37. This allows the selection of the data centre 
from which the ARQ is to be closed. 

3. Right click on the required data centre and select 'Close ARQ' from the drop down menu. 

When opened by right clicking a data centre, the 'Data Centre' frame is not shown in the form as 
the data centre will automatically be set to the one which was clicked. 

4. Right click on an ARQ in the Data Centres window and select Close from the drop down menu. 

When opened by right clicking an ARQ, the 'Data Centre' frame is not shown in the form as the 
data centre will automatically be set according to the data centre of the selected ARQ. In 
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addition, the Query Reference drop down list will be disabled and pre-populated with the 
selected query reference. 

5. Click the `Close ARQ' button on a Fast ARQ form. 

When opened by clicking the `Close ARQ' button, the 'Data Centre' frame is not shown in the 
form as the data centre will automatically be set according to the data centre of the ARQ. In 
addition, the Query Reference drop down list will be disabled and pre-populated with the query 
reference of the ARQ. 

Once the data centre and query reference have been selected, one of the following actions may be 
performed: 

Show Query Details 

Displays a form showing details of the selected query (see section 8.5.2.1). 

Close Query 

Closes the ARQ. 

Clicking the Close button will close the Close ARQ form. 

Once the request is closed the audit log (see Appendix 2) is written to the F:\UserArea on the appropriate 
Audit Server. 

• 

• '• 

Note that open ARQs can use a lot of disk space and should be closed when they are finished with. 

In particular once an ARQ has been run and the data sent to the Post Office and they have confirmed 
receipt of the data Sec Ops will close the ARQ and delete any ARQ data off of the audit workstations. 

Appendix  L WR Query Language
It had been the intention to include a simplified guide to the FLOWR query language as part of this 
manual. However, due to the complexity of the queries required and data to be analysed the W3C 
XQuery 1.0 Specification document has been included. 

Section 3.8 pertains to FLOWR, although it is probable that the additional information contained in this 
document will be required during the life of the system. 

D: \FLOW R_Guide\ 
W3C_XQuery 1_0_SE 
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••- • trii Jfflu]:F- ,, 11 A • *. 

Included is an example close log. 

1W
RFIOTH3076B.txt 
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A requirement of the audit system is the ability to transfer the created Excel spreadsheet results in a 
secure manner to the relevant customer. The mechanism that has been chosen to achieve this is to 
create a self-extracting PGP zip file via the Symantec Encryption Desktop application. Every user who 
activates the application for the first time has to go through a configuration process prior to being able to 
use the application. The process for configuring the application is as follows: 

Execute Symantec Encryption Desktop from the start menu. 

This may bring up the following Symantec error message, depending upon whether you are the first user 
to perform the configuration steps. This message can safely be ignored as the initial configuration 
corrects the error being reported. Select 'OK' to continue. 

Enab ng PGP 

if You qo rroinWW Muse PC* boo ten account, tnnot necess3Y tocompete etr. 
confquraeanwiza-c If You cf+c9- vow mid latr. outrun to Enanpton Desktop 
gapFiatun. 

On You want m emote POP robe evauabk from Mxs atom? 

~J n 

Ensure that 'Yes' is selected to enable PGP from this account and select the `Next' button. 
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roisrwnt 

licensing Assistant: Enter License

- Enter Ore kcense nvMer received for yaw c e,ra ,pgre'le beloor. if  you do 
not have a .cease rurbe,, You may use the product with toot featlres dsatied. 
You may also select ttis spoon to enter a kcense nunber at a later tee. 

C) Enter con, OCMse r ester 
t

POST 
OFFICE 

The PGP Zip functionality that is required can be utilised without the need for a licence key so select the 
'Use without a licence ...' option and select the 'Next button 

.. Nokcrraen ,-fed.r ifeaWevw&bedoded 

p ed-t lnfoeaoOon 

,k Snare - NW Drive 
EnaYpnc Masseur 2.P 'i ,.foal Usk E.noyption 

4 mouse ovc anon to learn abouteac h feature ofEnoyptue Desktop 

I V 

This screen confirms that only the PGP Zip functionlaity will be configured. If this is the case then select 
the 'Next' button. 

User Type 

-_. .. . . . . 

This assistant red help yurr configure E Ypuon Desktop and ri takze roar keys. 

please select one. 

I have toted Emcrypton Da!ktop before and : have g•istYg keys. 

Cancel f-Iekr 

Select the 'I am a new user' option and select the 'Next' button. 
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Encryption Desktop Setup Assistant 

PGP Key Generation Assistant 

a 

Ttvs aaMw,t woo help you peneratea new PGP key. A key 5 rewmed by each 
par Ece ant in the seared swat bop. Using a key wag also provide the ngheot level of 
conrcr>ence when creating PGP anduves and PGP Disks. 

_ If you would Ike more 1nrbrmataon on orrat a key Is and how PGP v+orts, choose the 
ExrypMx Desktop ` 1P merw. 

[f yeu use a hardware token lease insertt now. your token information wA d,spky 

Choose Next to [onYure, or Slap to hmw to the next section 

next > I wooer Hell 

POST 
OFFICE 

For the creation of Zip files it is not necessary to create PGP keys so on this page select the 'Skip' 
button. 

Encryption Desktop Setup Assistant 

PGP Messaging: Introduction 

Ency000n Desktop rttegraros seantessly MID cots me5005ln9. PGP automabnaYY 
detects and configure iteatf to secure the vast majority of swat accounts and 
servers. sMrP, POP, :MAP. hxchaege Server, and LOlus Notes access are seo net by pct'. 

tyext > Cxd  onto 

Ensure the 'Automatically detect my email accounts' option is NOT set and select the 'Next' button. 

Encryption Desktop Setup s,,tant 

Congratulations! 
Erto ytoon Desktop s nay ready for use. 

Lando bred conbd Ent+ yption Desktop front the Watdtwvs system tray 

Ease sertsibye documents by draggng there to the -GP Svedder One now located on 
your desktop 

F nob "] cry- Hem 

At this point the PGP Zip functionaliy has successfully been configured so select the 'Finish' button. 
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On subsequent activation of the Symantec Encryption Desktop software the user is presented with the 
following screen: 

To create a Zip file of the Audit results select the New PGP Zip' option. The generates the following 
screen: 

uy„ New PGP Zip 

Thu assistant wdl hep you secure ties and folders for storage or trans'er. Drag and crop your 
Res into the box, or use the buttons below to browse for your selecton. 

Name Size Type 

Drag and Drop files here 

• r :Med vnginals ^I :' 

The user should then drag and drop all the audit result files into the list area of the screen and optionally 
select the 'Shred originals' option if the files on disk are to be destroyed. The user should then select the 
`Next' button. 
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Select the 'PGP Self-Decrypting Archive' option and then select the 'Next' button. 

Lp

POST 
OFFICE 

At this stage the user should enter the passphrase that the customer will use in order to extract the 
results file. Note that the 'Next' button will only be enabled when the text in the Passphrase and Confirm 
areas match. When this is the case select the 'Next' button. 
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PGP Zip Assirtarri 

Sign and Save 

Sgnng your PGP Z:p akows von p.onta to verify :to suthenboty. Confirm your sgnng key 
and one sore location Delow. 

Hey 

POST 
OFFICE 

Save Location 

dowse... 

< flack [jjhlext ; ] Cancel Help 

The final stage is to specify the location that the PGP Zip file is to created in. This will typically be the 
medium that is going to be used to transfer the data. When specified select the 'Next' button. 

PGP Zip Assistant 

Finished 

your PGP Zip as sensed 

Zip 
Creating PGP Self Deer. p' -r -lr,ni:e OTH# 

y Reporting 
Encrypting with passphrase 

Files & Foldexs 
0TH3097B Horizon.xrnl 
OTH3097B-Hz-IOPMaitServiceSDAddress.xgl 

{ 

Finish <yrc

At this point select `Finish and the zip file creation will be completed. 
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